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Starlight Xpress Ltd

SXV-M5C
CCD camera user manual

Thank you for purchasing a Starlight Xpress CCD camera. \8fmetthat you will be
very satisfied with the results. The SXV-M5C is adium-resolution cooled CCD
camera, especially designed for colour astrononmeaging. The SXV-M5C uses a
Sony SuperHAD CCD, with 500 x 582 pixels in a 4.9m@.65mm active area.
SuperHAD devices have the greatest quantum effigiefiany interline transfer
CCD currently available and the use of high pertamoe microlenses on the CCD
surface gives the greatest possible throughpuglof to the pixels. This camera is a
next generation version of the parallel port drid$5C, but the use of an internal
USB?2 interface and the addition of an external guidmera option makes it
considerably more effective.

Please take a few minutes to study the conterttisomanual, which will help you to
get the camera into operation quickly and withaobtems. | am sure that you want
to see some results as soon as possible, so piea®eon to the ‘Quick Start’ section,
which follows. A more detailed description of imagitechniques will be found in a
later part of this manual.
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‘Quick Starting’ your SXV-M5C system

In the shipping container you will find the follomg items:

1) The SXV-M5C camera head.

2) A power supply module.

3) A 3 metre USB camera cable.

4) An adaptor for 1.25” drawtubes.
5) A CD with the ‘'SXV_M5’ software.
6) This manual.

You will also need a PC computer with Windows 988Hndows 2000 or Windows
XP. This machine must have at least one USB padea(ly USB2.0) and at least 64
Megs of memory. If you intend to view the finishietages on its screen, then you
will also need a graphics card capable of dispagn image with a minimum of 800
X 600 pixels and 65,000 colours. A medium spedificaPentium with between
500MHz and 3GHz processor speed is ideal.

Connecting up:

Plug the 5 pin DIN connector into the socket onpgbeer supply box, and plug the
power supply into the wall socket. The yellow LED the power supply should light.

USB input Autoguider

output

Power/ Sl

Autoguider

Power socket camera socket



Handbook for SXV-M5C Issue 1 August 2004

Wiring up your SXV camera

Power
plug

Camera head

S pin plug

Line Plug

Power
Supply

12V DC input
(optional)

Plug into

USB socket

PC computer

Connect the miniature 4 way power plug to the sbokethe rear of the camera and
screw the retaining ring into place. The LED onnba& of the camera will light a dim
yellow. The other connections should not be attdahil after the software has been
installed.

Installing the software:

Switch on the computer and allow it to ‘boot uphé@ you have the system ready to
run, insert the program disk into your CD drive aetect ‘Setup.exe’ if the disk does
not autostart. The initial installation is to setthe USB drivers required by the SXV
electronics. The files SXVIO.sys and Generic.syscapied to your
Windows\System32\Drivers folder and SXV_M5.inf gpeed to Windows\Inf.

After this, the program ‘SXV_M>5.exe’ will be instadl into your ‘CCD’ directory

and a new directory called ‘Autosave’ will now ebas the same drive. ‘Autosave’ is
where SXV_M5 will normally store its configuratidite, ‘SXVM5.ini’, and any

image files, which are recorded using the ‘Autosavede in SXV_M5 and saved in
FITs format.
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You now need to set up the camera control defésttiswn above), as follows:
Start SXV-M5C by clicking on the icon and selea thile’ menu. Now select ‘Set
program defaults’ and a window, which containswagous software settings, will
appear. Suggested starting defaults are as follows:

1) Background Image area
2) Interlaced image smoothing On
3) FITS Unsigned Integer format Off
4) Star mask size (area used for photometry and gg)idin 8 pixels

Red (or as preferred)

The other default settings are not important farent purposes and may be left as
the software start-up values for now.

Recording your first image:

We now have the camera and computer set up tiakees, but an optical system
is needed to project an image onto the CCD surfége.could use your telescope,
but this introduces additional complications, whiak best avoided at this early
stage. There are two simple options, one of whackvailable to everyone:

1) Attach a standard ‘M42’ SLR camera lens to the SNSC, using a 27mm spacer
to achieve the correct focal distance. M42 thrgeters are available from most
photographic stores, or from Starlight Xpress dsale
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2) Create a ‘Pin hole’ lens by sticking a sheet ofrahium baking foil over the end
of the 1.25” adaptor and pricking its centre witbnaall pin.

M42 Thread M42 Thread

Camera Camera Lens

I

—
— —

Loy gy

Tripod Bracket cCD 27mm M42 Adaptor

%

[

Attaching a Pentax thread camera lens

Camera 1.25” Adaptor
L L L L e \
Pin Hole
1 — ‘/
— —
e - irmJL T Aluminium Foil
FElastic Band

Making a simple pin-hole lens

If you use a normal lens, then stop it down todimallest aperture number possible
(usually F22) as this will minimise focus problearsl keep the light level reasonable
for daytime testing. The pin hole needs no suchsidjents and will work
immediately, although somewhat fuzzily.
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Point the camera + lens or pinhole towards a viteliFld clearly defined object some
distance away. Now click on the camera icon inttimdbar of the SXV-M5C software
and the camera control panel will appear (see gb&etect an exposure time of 0.1
seconds and press ‘Take photo’. After the expoandedownload have completed
(between 1 and 3 seconds) an image of some kin@ppkar on the computer
monitor. It will probably be poorly focused and anectly exposed, but any sort of
image is better than none! In the case of the pamladl that you can experiment with
is the exposure time, but a camera lens can bstadjfor good focus and so you
might want to try this to judge the image qualligttit is possible to achieve.

One potential problem with taking daylight imageshe strong infrared response of
the SXV-M5C and this will cause ‘soft focus’ withrmera lenses. Soft focus with
camera lenses is much reduced by keeping the apastting below F8. IR blocking
filters are available from various suppliers (Tfitechnology, Edmunds etc.) and are
recommended for the best results.

If you cannot record any kind of image, please ckebe following points:

1) Is the power LED on?

2) Does the software indicate that the camera eessssfully connected? An attempt
to take a picture will fail with an error messadehie USB is not properly installed. In
this case, try unplugging the USB cable and the@omeecting it after about 5
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seconds. Restart the camera software and seeahitink now. If not, check in
Windows device manager (via ‘System’ in ‘Controh&g and see if the BlocklO
device is installed properly.

3) If you cannot find any way of making the cameoak, please try using it with
another computer. This will confirm that the camer®K, or otherwise, and you can
then decide how to proceed. Also check on our velicssee if there are any updates
or information about your camera software that ntigblp. The message board might
prove useful to ask for help with getting your cear@perating properly.

Our guarantee ensures that any electrical faults eorrected quickly and at no cost
to the customer.

Decoding the image to colour:

Once you have a reasonably clear and well-expasade, you might like to try
generating a colour picture from it. The procedarguite simple and may be carried
out as follows:

1) Check the ‘Set program defaults’ menu and ensatetiie ‘Pixel’ and ‘Line’
offsets are both unselected.

2) Click on ‘Colour’ in the main menu and then sel&stnthesise Colour Image’.

3) Select ‘Apply Anti-Alias’, but leave the other optis switched off.

4) Click on ‘Create Image’.

After a few seconds a recognisable colour imagelshae displayed, although the
colour ‘balance’ may need correction. This is eggbctrue if your image was taken
indoors with artificial lighting, which can makeeything look very orange.

If the colour image shows white spots or patchdwre/ no colour is present, then the
original exposure time was too long and some piastsoverloaded. In this case, you
need to take a new image with significantly legsasxre time, or with the lens
stopped down a little further.

Correcting and refining the colour image:

The colour balance of your image may be adjusteskelgcting ‘Colour’, followed by
‘Set Colour Balance’'.

You are presented with three histograms, whichesgmt the Red, Green and Blue
content of your image, with limits, which can bguastied by slider controls.

A good quality colour image will present three, gbly similar; histograms, and any
small colour bias may be seen as different offabts/e zero and different widths of
the main bulk of the histograms. Moving the lowmnit setting of a histogram will
adjust the overall colour bias of the picture, viltb amount of the particular colour
concerned being reduced by moving the limit ingbsitive (to the right) direction.
The location of the pointer represents the newo’zefrthe histogram. For instance, if
your image is a little too red, you can reduce Hyisetting the lower pointer on the
red histogram to, say, 4, and then clicking on @fually, you can increase the red
content by reducing both the blue and green content



Handbook for SXV-M5C Issue 1 August 2004

In some cases, there may be a difference in cdliasrbetween the faintest and
brightest objects. When this happens, first redbeeerror of the faint detail, using
the ‘START sliders, and then correct the brighjeais by using the ‘MAX’ sliders.
The ‘MAX’ slider allows you to vary the ‘slope’ dhe transfer curve and so change
the way that the balance alters from faint to dragtail.

Other options in the ‘Colour’ menu are ‘Apply Atitas’ and ‘Adjust

Chrominance’. We have already used the Anti-Aliisrfas an option during colour
synthesis, but it will be helpful for you to knots purpose. Basically, the AA filter is
designed to remove colour errors at sharp tramsitad brightness. Because of the
spatial characteristics of the grid of filters tie €CD, a sharp edge in the image will
overlay certain filters, but miss adjacent onesewthe colour synthesiser equations
process the data from this region, there will bénaorrect result when these pixels
are processed and a line of abnormal colour wilbfothe transition edge. This is
well seen in images of stars, which often take str@ng colour bias, quite different
from the expected star colour. The AA filter scéms colour image data and searches
for fine details with rapidly changing colours. Weeer these errors occur, the filter
substitutes the equivalent and equal values ofgien and blue, thus changing the
deviant colour into neutral grey. The result is@chmsmoother colour image, with
clean transitions around stars and other fine ildefBine AA filter may be used as
many times as is desired, but its additional effedtl be very slight after about 3
passes of the image.

The ‘Adjust Chrominance’ option is not needed farstniimages, but can be useful for
removing atmospheric dispersion from images ofplaeets. ‘Adjust Chrominance’
permits you to move the red and blue frames wispeet to the green frame and so
compensate for the displacement of the coloursechbyg the atmosphere. To use the
AC function, shift the red and blue images untd fhanetary disc has an evenly
coloured periphery and any red and blue fringeapiear.

Enhancing your image:
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Your first image may now be reasonably good, big itnlikely to be as clear and
sharp as it could be. Improved focusing and exmosalection may correct these
shortcomings, and you may like to try them befgplying any image enhancement
with the software. However, there will come a paulten you say, “That’s the best
that | can get” and you will want to experimenttwitarious filters and contrast
operations. In the case of daylight images, thegssing options are many, but there
are few that will improve the picture in a usefudyw

The most useful of these are the ‘Normal Contra®t&h’ and the ‘High Pass Low
Power filter. The high pass filter gives a moderamhprovement in the image
sharpness, and the effects of image processing.clmi be very effective on daylight
images. Too much high pass filtering results irkdarders around well-defined
features and will increase the ‘noise’ in an imeganacceptable levels, but the ‘Low
Power’ filter is close to optimum and gives a nycgtharpened picture, as above.

The ‘Contrast’ routines are used to brighten (df)die image highlights and
shadows. A ‘Normal’ stretch is a simple linear @tem, where two pointers (the
‘black’ and ‘white’ limits) can be set at eithedsiof the image histogram and used to
define new start and end points. The image ddteeis mathematically modified so
that any pixels that are to the left of the ‘blapkinter are set to black and any pixels
to the right of the ‘white’ pointer are set to wiiThe pixels with values between the
pointers are modified to fit the new brightnesgribstion. Try experimenting with

the pointer positions until the image has a plepbiightness and ‘crispness’.

At this point, you will have a working knowledge lobw to take and process an SXV-
M5C image. It is time to move on to astronomicaagimg, which has its own,
unique, set of problems!

kkkkkkkkkkkkkkkkkhkkhkkhkkkkhkkkhkkkkkkkkkkkkkkhkkkhkkkkkkkkkk kkkkkkkkkkkkkkkkkk

Astronomical Imaging with the SXV-M5C
1) Getting the image onto the CCD:

It is fairly easy to find the correct focus settiiog the camera when using a standard
SLR lens, but quite a different matter when theiMdttached to a telescope! The
problem is that most telescopes have a large rahfgeus adjustment and the CCD
needs to be quite close to the correct positionreefou can discern details well
enough to optimise the focus setting. An additicrmmhplication is the need to add
various accessories between the camera and tekestopder that the image scale is
suitable for the subject being imaged and (somefjrieeinclude a ‘flip mirror’ finder
unit for visual object location.

A simple, but invaluable device, is the ‘par-foegiepiece’. This is an eyepiece in
which the field stop is located at the same distdnam the barrel end, as the CCD is
from the camera barrel end.



Handbook for SXV-M5C Issue 1 August 2004

When the par-focal eyepiece is fitted into thedetge drawtube, you can adjust the
focus until the view is sharply defined and theegbpf interest is close to the field
centre. On removing the eyepiece and fitting thé@a@mera, the CCD will be very
close to the focal plane of the telescope and shmdord the stars etc. well enough
for the focus to be trimmed to its optimum setting

Several astronomical stores sell par-focal eyepidmat you can also make your own
with a minimum of materials and an unwanted KellmePlossl| ocular.

Just measure a distance of 22mm from the field stdipe eyepiece (equivalent to the
CCD to adaptor flange distance of the camera) aakkran extension tube to set the
field stop at this distance from the drawtube &ut-down 35mm film cassette
containers are a convenient diameter for makingpaeer tube and may be split to
adjust their diameter to fit the drawtube.

Another popular solution to the ‘find and focusbpltem is the ‘flip mirror’ unit.
These operate on a similar principle to the sitghs reflex camera, where a hinged
mirror can drop into the light path and reflect tage through 90 degrees into a
viewing eyepiece.

In this case, the camera and eyepiece are madegamwith each other by locking
up the mirror, focusing the camera on an easy tlgach as a moderately bright star
and then flipping the mirror down to view the saster with the eyepiece. Once the
eyepiece has been locked into the correct posiin can use it to focus on the
image by lowering the flip mirror and operating teescope focus wheel until the
image is sharp. When the mirror is raised, the enady fall onto the CCD surface
and should be accurately in focus. Most flip mimaits allow several adjustments to
be made, so that the image can be centred prapetyg eyepiece and CCD fields,
which are not necessarily coincident when you bist your unit!

10
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Opinions vary as to the utility of flip mirrors. @i are a convenient way to find and
focus, but they add quite a bit of extra lengthwiaetn the camera and telescope. This
can be very inconvenient with Newtonians, and nlot aetter with SCTs, especially

if the assembly is somewhat flexible. They also endklifficult to use a focal reducer
with your camera, as the rapidly converging lighte from a reducer cannot reach all
the way through the flip mirror unit to the CCD . If you are using one of the
popular F3.3 compressors for deep sky imaging,widNOT be able to include a

flip mirror unit in front of your camera and a pgacal eyepiece is your best option.

Whichever device you use, it is necessary to set ggod optical match between your
MX5C and the telescope. Most SCTs have a focal cdtaround F10, which is too
high for most deep sky objects and too low forglanets! This problem is quite easy
to overcome, if you have access to a telecomprégsadeep sky) and a Barlow lens
for planetary work. The new Meade F3.3 compresswoery useful for CCD imaging
and | can recommend it from personal experienaods not require a yellow filter
for aberration correction, unlike some other desjgo it can be used for colour
imaging. Barlow lenses are less critical and mgsts can be used with good results.
However, if you are buying one for CCD imagingetommend a 3x or 5x amplifier,
or the planets will still be rather small in youarages. As a guide, most CCD
astronomers try to maintain an image scale of aB@ut seconds per pixel for deep
sky images. This matches the telescope resolutitimet CCD resolution and avoids
‘undersampling’ the image, which can result in squstars and other unwanted
effects. To calculate the focal length requiredtfas condition to exist, you can use
the following simple equation:

F = Pixel size * 205920 / Resolution (in arc se®)nd
In the case of the SXV-M5C and a 2 arc secondgipef resolution, we get

F =0.0096 * 205920/ 2 = 844mm

11
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For a 200mm SCT, this is an F ratio of 844 / 20®=22, which is easily achieved
with the Meade converter and appropriate extensiba (as supplied with the
converter). Moderate deviations from this focalgénwill not have a drastic effect
and so any F ratio from about F3.3 to F6 will gijeed results.

The same equation can be used to calculate thefenapbdn required for good
planetary images. However, in this case, the shergosures allow us to assume a
much better telescope resolution and 0.25 arc skscoer pixel is a good value to use.
The calculation now gives the following result:

F =0.0096 * 205920/ 0.25 = 6754mm

This is approximately F34 when used with a 200mnT &ad so we will need a 3.4 x
Barlow lens. Such lenses are not available, buctimemon 3x version will be good
enough for all practical purposes.

An accessory that you will find valuable is the ‘Btb T’ adaptor. These are short
tubes that carry an external M42 thread at oneaenldan internal ‘T’ thread at the
other end, and are available from most photogragpinply shops. The T thread is the
same diameter as the M42 (42mm x 1mm) thread tsuahmtch of 0.75mm and is
used for many astronomical accessories, sucheotapressors. An M42to T
adaptor will allow you to easily interface with tally any device in the astronomical
catalogue.

Achieving a good focus:

Your starting point will depend on the focus aidlgny, which you are using. With
the par-focal eyepiece, you should slip the eyepieto the drawtube and focus
visually on a moderately bright star (abolftrBagnitude). Now withdraw the
eyepiece and carefully insert the camera nosepietiiat is bottomed against the
drawtube end and lock it in place. With the fliprmar unit, all that is needed is to
swing the mirror down and adjust the focus un# $itar is sharply defined and
centred in the viewing eyepiece. Now lift the miramd you are ready to start
imaging.

SXV_M5C has a focus routine that will repeatedlydibad and display a 100 x 100
pixel segment of the image at relatively high spééls focus window may be
positioned anywhere in the camera field and cadifig@ayed with an adjustable
degree of automatic contrast stretching (for faogigin faint stars). To use this mode,
start up the software and select the MX camerafade (File menu). Set the camera
mode to ‘Fast’ and select an exposure time of brsgcPress ‘Take Picture’ and wait
for the image to download. There is a good chahaeyour selected star will appear
somewhere within the image frame and it shouldlbgecto a sharp focus. If the
focus is still poor, then it may appear as a pak df light with a dark centre (the
secondary mirror shadow in an SCT, or NewtoniamwIselect the ‘File’ menu again
and click on ‘Focus frame centre’; you can now tiemouse pointer to click on the
star image and the new focus frame co-ordinatdeitlisplayed. Now return to the
camera interface window and click on ‘Start’ in thecus frame. The computer will
now display a continuous series of 100 x 100 pixelges in the focus window and
you should see your selected star appear somewloseto the centre. A ‘peak

12
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value’ (the value of the brightest pixel) will albe shown in the adjacent text box and
this can be used as an indication of the focusracguAlthough the peak value is
sensitive to vibration and seeing, it tends towardsaximum as the focus is
optimised. Carefully adjust the focus control omytelescope until the image is as
sharp as possible and the peak value reaches amaxiWait for any vibration to

die down before accepting the reading as reliahdeveatch out for bursts of bad
seeing, which reduce the apparent focus qualityteQiten, the peak value will
increase to the point where it is ‘off scale’ aB8@nd in this case you must halt the
focus sequence and select a shorter exposure ivighuto use the peak value as an
indicator. Once you are happy with the focus quathieved, you might like to trim
the settings of your par-focal or flip mirror eyepé to match the current camera
position. Although you can reach a good focus leyahove method, many observers
prefer to use additional aids, such as Hartmanrksn@s objective cover with two or
three spaced holes) or diffraction bars (narrovalperrods across the telescope
aperture). These make the point of precise focsi®etd determine by creating
‘double images’ or bright diffraction spikes aroustdrs, which merge at the setting
of exact focus. The 12-16 bit slider control alloyesi to adjust the contrast of the
focus frame for best visibility of the star imadfedefaults to maximum stretch (12
bits), which is generally ideal for stars, but wéw stretch value is better for focusing
on planets.

Taking your first astronomical image:

| will assume that you are now set up with a fodusamera attached to a telescope
with an operating sidereal drive. If so, you argvnio a position to take a moderately
long exposure of some interesting deep-sky astrazadrmobject (1 will deal with
planets later!). As most drives are not very adeub&@yond a minute or two of
exposure time, | suggest that you find a fairlyghtiobject to image, such as M42,
M13, M27 or M57. There are many others to choosmfrbut these are good
examples.

Use the finder to align on your chosen object duath tcentre accurately by using the
focus frame and a short exposure of between 1 aed@&nds. The '12-16 bit’ slider

in the focus frame allows you to adjust the imageti@ast if you find that the object is
too faint with a short exposure. Once properly Ehand focused, take an exposure
of about 60 seconds, using the ‘Fast’ mode andrebgsbe result. Initially, the image
may appear rather barren and show only a few dtargever, there is a great deal of
data hidden from view. You can get to see a lahif, without affecting the image
data, if you go to the ‘View’ menu and select ‘Al@ontrast Stretch Image’. The faint
image data will then appear in considerable datadl | think that you will be
impressed by the result!

If you are happy with the image, go to the ‘Fileéinu and save it in a convenient
directory.

Now you need a ‘dark frame’, if the best results tarbe extracted from your raw

image. To take this, just cover the telescope tilvavith the lens cap, or drop the
flip mirror to block the light path to the CCD (makure that this is light tight), and

13
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take another 60 second exposure. This image w#l pieture of the dark signal
generated during your exposure and it should bedsawth your image for use in
processing the picture. The SXV-M5C generates litly dark signal and so dark
frames are not essential for short exposures sftlem a few minutes, but it is a good
idea to record at least one for each exposureused during an imaging session. As
variations in ambient temperature will affect tragldsignal, it is best to take the dark
frames within a few minutes of capturing your imaigeor the same reason, it is not
wise to use ‘old’ dark frames if you want the besssible results, however, some
software allows you to scale library dark framesnatch the image (e.g. AstroArt).

‘Flat fields’ are often recommended for optimisiihg results from your CCD
camera, but these are generally less importantdadnframes, especially if you
make sure that the optical window of the cameke dust-free. The purpose of a
flat field is to compensate for uneven illuminat@amd sensitivity of the CCD and it is
better to avoid the need for one by keeping thesglean and unvignetted. | will
ignore flat fielding for current purposes and ddsezthe process in detail at a later
stage.

Processing the deep-sky image:

1) Make sure the ‘Auto Contrast Stretch’ is switthdf and load your image into
SXV_M5C. Select ‘Merge’ and then ‘Subtract Darkiied. Pick the appropriate dark
frame and the software will then remove the dagkai from your image, leaving it
somewhat darker and smoother than before.

14
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2) The resulting image will probably look faint andlgdwith a bright
background due to light pollution. It is now tineegrocess the ‘luminance’
(brightness and contrast) of the image to get #s sual appearance. First,
use the ‘Normal’ contrast stretch to darken thekgeaund by setting the
‘Black’ slider just below the main peak of the bigtam. Alternatively, you
can use the ‘Remove Background’ option to let thfensare decide on the best
setting. This will greatly reduce the backgrouniginess and the image will
begin to look rather more attractive. You can nownbrightening the
highlights with another ‘Normal’ stretch, in whiglou bring down the ‘White’
slider to just above the main image peak. The $sttihg for this is rather
more difficult to guess and you may need sevetahgits before the result is
ideal. Just use the ‘Undo last filter’ functionniécessary, to correct a mistake.

3) The image will now look quite impressive ancpk that you are pleased with
your first efforts! Further small refinements asually possible and you will become
expert at judging the best way to achieve thegmasexperience increases. As a
rough guide, the ‘Filters’ menu can be used tosrarsoften or noise reduce the

15
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image. Strong ‘High Pass'’ filters are usually ngioad idea with deep sky images, as
the noise will be strongly increased and dark riwdsappear around the stars, but a
‘Median’ filter can remove odd speckles and a Mildsharp Mask’ (Radius 3, Power
1) will sharpen without too much increase in noise.

Other things to try, include adjustment of the colsaturation and summing several
images for a better signal to noise ratio. Sumneenrg be done in the ‘Merge’ menu
and involves loading the first (finished) imagdges@ng a reference point (a star) then
loading the second image and finding the samenstarthe mouse. Once the
reference is selected, you can either add direatlgyerage the images together.
Averaging is generally better, as you are lesdylik@ saturate the highlights of the
picture. The signal-to-noise ratio will improveaatate proportional to the square root
of the number of summations (summing 4 imagesduillble the signal-to-noise), but
different exposures must be used. Summing an image wittvwdehot change the
S/N ratio!

Although | have concentrated on the use of a tej@séor deep-sky imaging, do not
forget that you have the option of using an ordiraamera lens for impressive wide-
field shots! A good quality 200mm F3.5 lens withiafiared blocking filter will yield
very nice images of large objects, such as M31, N5 etc. If you cannot obtain a
large IR blocker for the front of the lens, it isitg acceptable to place a small one
behind the lens, inside the adaptor tube.

Taking pictures of the planets:

Planetary imaging is in many ways quite differeoti deep sky imaging. Most deep
sky objects are faint and relatively large, so @risfocal length and a long exposure
are needed, while planets are bright and very smedding long focal lengths and
short exposures. High resolution is critical toiaeing good results and | have
already shown how a suitable focal length can b®utaed and produced, using a
Barlow Lens.

Many camera users comment on the difficulty of iingdthe correct focus when

taking pictures of Jupiter etc. This is usually du@oor seeing conditions, which are
only too common, but may be due in part to pooliroaltion of your telescope.
Please ensure that the optics are properly aligaeshown by star testing, or by using
one of the patent collimation aids that are widmlgilable. It is also better to use a
star for initial focusing, as planetary detail iffidult to judge in bad seeing. Although
the star will also suffer from blurring, the eyanaaore easily gauge when the most
compact blur has been achieved!

You could begin by imaging lunar craters, but tbhkvar content is low and so |
recommend Jupiter, Saturn or Mars. The rapid vianiatof seeing which accompany
planetary imaging, will ruin the definition of alio26% of your images and so |
recommend setting the camera to run in ‘Autosaveden This will automatically
take a sequence of images and save them with sia|d#@ names in your
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‘Autosave’ directory. Dozens of images will be sayvieut only one or two will be
satisfactory for further processing.

To start the Autosave process, call up the SXV Qarhrgerface and select the
‘Continuous Mode’ check box at the top (make sheerest are unchecked). Now
check the ‘Autosave Image’ checkbox near the botbthe window. If you now
click on ‘Take Picture’ the automatic sequence dtin and will not stop until you
press a computer key. The images will be savedTia format with sequential names
such as ‘Img23, Img24...." and will be found in theutosave’ directory (or a sub-
directory of Autosave, set up in the program deaoienu).

The exposure time needed for good planetary imagasch that the image histogram
has a peak value at around 127 and does not exteald above 200 (Ignore the
major peak near zero, due to the dark backgrouhgdu use too short an exposure
time, the image noise level will be increased, i&malo long a time is used you will
saturate the highlights and cause white patchéseodecoded image. With the
recommended focal length, Jupiter and Mars wilhbwted an exposure time of
between 0.1 and 1 seconds and Saturn will needeleet®.5 and 2 seconds.

Processing a planetary image:

Planetary images have one major advantage oversigamages, when you come to
process them — they are MUCH brighter, with a gpoadingly better signal to noise
ratio. This means that aggressive sharpeningdilieay be used without making the
result look very noisy and so some of the effe€{gsoor seeing can be neutralised.

A raw image

Try applying an ‘Unsharp Mask’ filter with a radio§5 and a power of 5. This will
greatly increase the visibility of any detail o thlanet, but the optimum radius and
power will have to be determined by experimengéneral terms, the larger the
image and the worse the seeing, then the wideaathias for best results. My Jupiter
shots are usually about half the height of the G@ilme and I find that the ‘radius 5,
power 5’ values are good for most average seeinditons. If you have
exceptionally good conditions, then a reductioR#8, P=3 will probably give a
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more natural look to the image, as too large ausadnd power tends to outline edges
with dark or bright borders.

As a finishing touch, the application of a Medidtef or a Weighted Mean Low Pass
filter can be useful to smooth out the high frequyenoise after a strong Unsharp
Mask.

As with deep-sky images, it is advantageous to glametary images together to
improve the signal to noise ratio. In this case,‘ttveraging’ option should always be
used, or the result is likely to exceed the dynamige of the software and saturate
the highlights. Aligning the images is always sammgj of a problem, as there are
rarely any stars to use when imaging the planeits)ipiter’'s satellites can be useful
reference points. Otherwise, you will have to fandell-defined feature on the planet,
or estimate where the centre of the disk is locéedne more sophisticated software
can automatically align planetary images, but hdofind it especially difficult to do
by eye.
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Other features of SXV_M5C
‘Slew & Sum’ imaging:

The SXV-M5C can be used in an automatic image-gstgakode, called ‘Slew &
Sum’. The camera is set to take several sequenmdsures, which are automatically
‘slewed’ into alignment and then summed togethethigysoftware. This mode can
help to overcome a poor RA drive by summing imagas have exposure times
shorter than the drive error period. The resulimgge has more noise than a single
exposure of the same total length, but this metifochaging is still an effective way
of making long exposures.

To take an S&S image, go to the camera interfacelow and select an exposure
time for one image of the sequence. Do not useyashert exposure time, as the
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read-out noise will become dominant. About 30 sdsas a reasonable minimum.
Now go to the ‘Multiple Exposure Options’ and seélacyumber of exposures to take.
You can also select to average the images, rdthardadding them, and there is a
‘Alternative Slew Mode’ available, which uses ttarelation of image areas, rather
than a single star. This mode can be better inedstas fields.

Another option is ‘Auto remove dark frame’. Thisadvisable with S&S images, as
the slewing will mis-register the images with agté&ndark frame that is applied to the
finished sequence. To use this option, you willchaelark frame, taken with the same
exposure time as a single image from the sequdinigis stored on drive C with the
name ‘dark.def’

Now click on ‘Take Photo’ and the sequence willibeg
Taking and using a flat field:

Flat fields are images, which display only the &aans of illumination and

sensitivity of the CCD and are used to mathemdyicabdify a wanted image in such
a way that the errors are removed. Common flad #efors are due to dust motes on
the camera window and vignetting effects in thaagpsystem of the telescope. Dust
motes act as ‘inverse pinholes’ and cast out-ofifamages of the telescope aperture
onto the CCD chip, where they appear as shadomuds- Most optical systems
show some vignetting at the edges of the fieldeeisly when focal reducers are
used. This causes a brighter centre to show inesyagspecially when there is a lot of
sky light to illuminate the field.

If dust motes are your main problem, it is bestléan the camera window, rather
than to rely on a flat field to remove the do-niiat fields always increase the noise
in an image and so physical dust removal is thedgason. If you have serious
vignetting, first check whether the optical systesn be improved. The most likely
cause of this problem is trying to use too poweafdlegree of optical compression
with a focal reducer and you might want to try nmgvthe camera closer to the
reducer lens.

If you really do need to use a flat field for imag@rection, then it must be taken with
care. It is most important that the optical sysMdST NOT be disturbed between
taking your original images and taking the flatdieAny relative changes of focus
and rotation etc. will upset the match betweenfitdtl and image and the result will
be poor correction of the errors. The other netessi recording a good flat field is a
source of very even illumination for the telescéipéd. This is surprisingly difficult

to achieve and many designs of light source hapeaed in the literature and on the
Web. These usually consist of a large wooden baxtaining several lamps and an
internal coating of matt white paint, which is mdoover the objective of the
telescope to provide an evenly illuminated surfad¢ese can work well, but | prefer a
simpler method, as follows:

Most imaging sessions begin or end in twilight andhe dusk or dawn sky can
provide a distributed source of light for a flalfi. However, using the sky directly is
likely to result in recording many unwanted starspatches of cloud etc., so a
diffuser needs to be added to the telescope. Aal idaterial is Mylar plastic
draughting film, obtained from an office suppliearehouse. It is strong and water
resistant and can be easily replaced if damageetcSta piece of the film loosely
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across the aperture of your telescope and poinh#teiment high in the sky, to avoid
any gradient in the light near the horizon. Nowetakveral images with exposure
times adjusted to give a bright, but not overloagbécture. Averaging flat field
together is a good way to reduce their noise doution and so recording 4, or more,
images is a good idea.

To use your flat fields, they must first have akdiaame subtracted. Although this
may appear to be unimportant with such brightlaht short exposures, there is the
‘bias offset’ of the camera in each image and ¢his produce an error in the final
correction. As we are mainly interested in the @y very short exposure dark
frame will give a good result. The dark subtragtaedges should then be averaged
together before use.

After the above procedures have been executedatifeeld will be ready for use.
Load up your image for processing, subtract th& ttame and then select ‘Apply
flat field’ in the ‘Merge’ menu. The result shoubde an image with very little sign of
the original artefacts.
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The accessory ports

The SXV-M5C is provided with two ports for use wahcessories. The Autoguider
output port is a 6 way RJ11 socket, which is combpatvith the standard autoguider
input of most telescope mounts. It provides 4 &etow opto-isolator outputs and a
common return line, capable of sinking a minimunbiA per output. This socket
may be used for telescope control if the SXV-M5Ensployed as an autoguider, but
is primarily intended to be the control output floe optional add-on autoguider
camera head, available for use with the SXV-M5C.

The high density parallel port socket provides bmhtrol and power for the add-on
autoguider, but also includes a pair of serialgtwt use with other devices.

Using the built-in serial ports
The SXV-M5C incorporates two fast serial portsdee with external accessories.

The ports are available on 5 pins of the 18 waynector that is provided for the
autoguider and may be accessed by plugging inrelf'gert divider box’. The divider
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box and cables are available as an accessory anenzhained in series with the
autoguider cable, when the guider is in use, or beaysed on its own.

The two serial connections are in the form of staddQRS232 PC style plugs and
provide TX, RX and Ground connections at RS232l&&ccess is via commands
sent through the USB connection and, at the timeriiing, is limited to any serial
controls that are provided by the SXV softwares kxpected that many more
functions will be added as the software is upgraded
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STAR 2000

The SXV-M5C may be used with our patented self-mggystem ‘STAR 2000'.
This can greatly ease the process of recording éxpgsure deep-sky images.

Using ‘STAR 2000’ self-guiding with the SXV-M5C

How S.T.A.R. 2000 works:

S.T.A.R. 2000 is a unique and patented method toihaatically controlling your
telescope drives, while capturing a long exposunage with your Starlight Xpress
CCD camera. Unlike off-axis guiding devices andldt@D self-guiding cameras,
S.T.A.R. 2000 can guide on almost any object, wigchsible within the CCD
frame! You have the entire CCD field of view to ose from and can even select a
slowly moving target, such as a comet nucleusstaraid, to guide on during the
exposure.

The principle of S.T.A.R. is based on the speci@aDGstructure of the chips used in
our SXV_M5, M7 and M9 cameras and it cannot be wgéd ‘full frame’ CCDs,

such as the popular Kodak devices. It is also irgatible with our HX516 camera.
The M5, M7 and M9 use ‘Interline Interlaced’ CCD$y which are constructed with
each pixel split into two vertically stacked halvEsach half can be ‘read out’
independently, so it is possible to integrate @lerposure on one field of half pixels,
while the other field is read out at short intesvahd the data used for guiding the
telescope. Half way through the exposure, we cad oeit the contents of the
integrating field, swap fields, and integrate tastiof the exposure on the other field.
This preserves the best image resolution and eiteg‘aliasing’ effects.

To give a fast guider update rate, the guidinglfislread out as an 80x40 window
around the guide object, while the unused linescammped’. Using this technique, it
is possible to feed corrections to the telescopedrs often as one every second
when guiding on a fairly bright star (typically alionag. 11). The sub-pixel guiding
accuracy of S.T.A.R. 2000 will give you tightly defd, round star images, however
long the exposure time that you use!
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The advantages of S.T.A.R. are very great, buetheg two negative aspects, which
you should be aware of. The main loss is in thasisgity of the CCD, as only half of
the pixel area is integrating an image at any ane.tThis is slightly offset by the
halving of the dark current, which also resultg aan be completely compensated
for by increasing the exposure time — not a bidbf@m when the camera can guide
itself! The other problem is that the CCD amplifirust be switched on momentarily
to read out each guider frame. Despite the shodgiinvolved, this results in some
contamination of the upper left hand corner ofithage, by light emitted from the
amplifier transistors (electro luminescence), dns heeds the subtraction of a special
dark frame to remove it. However, the glow is qigti@t and may be ignored on
many images, or it can be removed with the ‘Gradiéier’ in the ‘Filters’ menu.

What you need:

To use S.T.A.R. 2000, you must have a telescoge "iito guider’ capability. Most
modern SCTs have this facility in the form of aié |RJ11’ telephone style
connector on the mounting base or handset. If \gsmape is ‘ST4 compatible’ it
should work with S.T.A.R. 2000. Adaptors for otheounts, such as the Vixen
Skysensor, are available from Starlight Xpresshéncase of a ‘difficult’” mount, an
add-on relay box is available to switch higher ents and opposite polarity circuits.
The system has been tested with the LX200, LX50Geldstron CI700 German
mounts with good results, but almost any modernmhaiil work well. Please note
that the RJ11 cable supplied with the camera hasdhnectors fitted on opposite
sides of the 6 way cord — other cables may nobbepatible!

Setting up the system:

For best results, it is important to set up yolggeope mounting as accurately as
possible. Alt-Az mounts can be used with S.T.A.80@ but will cause field rotation
during exposures and are often rather poor at dmtoaxtking. We recommend that
you always use an equatorially mounted ‘scope, istpolar axis accurately aligned
on the pole. If your mount is prone to sudden shaftaim point during tracking,
usually due to poorly made gears or bearings, $1@A.R. will be unable to fully
compensate and some trailing will result. Slow smeboth errors in position are well
corrected and so this is what you should aim ftveck that all your drive gears are
firmly fixed to their shafts (loose gears are sigipgly common!) and that they
engage closely, without binding. The tracking olnmanounts can be improved by
adding a deliberate bias to the East. A small weaghthe Eastern fork tine will
usually be effective.

Connect up the computer and camera in the usuabwadynstall the camera onto the
telescope. Next, take the 6 way RJ11 telephonedrdglug one end into the guider
output of the SXV camera. This output is a ‘switth&gnal, compatible with inputs
designed for use with an ST4 guider. It is alscsfimde to use a serial connection to an
LX200 compatible RS232 input, but to do this yoed&o have a serial port to RJ11
cable from the back of the computer to the RS2ptinf the mount. This connection
allows other ‘goto’ control signals to be senthe thount, but may be less convenient
if you do not require this facility. Which outpuby use will also depend on your
telescope, but the Meade LX200 and its clones @amgatible with serial control,
although the LX200GPS still has a software issubeatime of writing. All other
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mounts will use the guider output from the caménace the above connections have
been made, you are ready to start up the system.

Starting to guide:

Power up the camera and computer, and start thectgbe drive. Click on ‘Set
Program Defaults’ and examine the current settilmgthe ‘Telescope Guiding’ box,
set the interface selection to ‘LX200’, or ‘Via Qaol box’ (ST4 output of camera), as
appropriate. Also select ‘COML1’ or ‘COM2’ if usirsggrial control, according to
availability - ‘COML’ is the 9 pin port provided dhe rear panel of most portable PC
computers.

Now adjust the other values as follows:
1. Set ‘RA Pixels per sec’ and ‘Dec Pixels per se®.to
2. Set all backlash and hysteresis values to 0.
3. Set ‘Ignore drift < 1 pixel’ to OFF.
4. Set '70mS delay between direction changes’ to ON.
5. Set ‘Default guide training time’ to 2 secs.

These values can be refined later, but should weakonably well with most
telescopes.

You can now test communications between the compuig telescope mount, as
follows:

1. Press ‘Set slew values’, followed by ‘Save Progiaefaults’.
2. Select ‘Telescope control’ in the ‘File’ menu.

3. Press each button in turn and observe the LED kintipe rear of the camera.
As each is pressed, the lamp will brighten and gbaolour between red and
green. The telescope will also begin to slew inappropriate direction. This
slew will be slow (unless you have deliberatelyestdd a fast slew mode via
the telescope controls) and so you will need tenlkesit through the telescope
eyepiece, by watching stars drift by. If the LX20@tput is in use, the LED
will not respond, but the ‘scope will still slewrcectly.

If all is well, you can proceed to testing the gngdsystem itself, otherwise, check
your setup and confirm that the correct COM paot ist selected.

Refit the CCD camera to the telescope and rotaie that the mounting bracket is
aligned approximately East-West. Focus in the usagi on a star and then point the
‘scope towards the object you have selected foginga | recommend something
near the celestial equator and with a reasonalstdauof useful guide stars around
it, to make life a little easier!

Take an image of the field, using an exposure bifrfesecond and selecting ‘Auto
contrast stretch’ in the ‘View’ menu. Several stsinsuld be easily visible in the
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displayed image, but, if not, try increasing the@sure time a little. Remember that
the ideal guide star is one that is bright enowghet easily detected in a 1 second
exposure, or less.

Once you have the test image and can see an ajgbeoguide star, go to the ‘File’
menu and click on ‘Select guide star’. Now click tnouse on the image, with the
pointer on your selected star. The pointer will puanto the star and a message box
will show its co-ordinates in a message windowesprOK’ to confirm the selection.
You have now selected the guide object and areyrgastart an exposure.

Call up the camera control panel and select a dnskr the length necessary for
your guide star) exposure time. Click on the cheak ‘Self guide next exposure’ and
‘1 second’ should appear in the self guide expobore Now set the exposure for the
image (try 5 minutes as a good starting point) eiuk on ‘Take picture’.

The control panel will disappear and be replacethbyguider window, with a set of
number boxes above it. The guider software will rattempt to centre an 80 x 40
pixel box around the guide star and this will appedhe guider window after a few
seconds delay. The number boxes will also begshtav the star co-ordinates and the
differential guiding error as each new guide fisldlisplayed.

If all is well, the error numbers will remain atrgeally less than 1 pixel and the star
image will sit steadily at the same location in thede box. If, however, the star
begins to drift away, it is possible that your @riyuide directions are reversed in
either RA or DEC (or both). Press ‘ESC’ to stop éixposure and go back to the ‘Set
Program Defaults’ menu, where you can use the ‘Suisglirection’ and ‘Swap e/w
direction’ check boxes to reverse the appropriateedAnother problem, which can
arise, is that the star may remain close to theecoposition, but will oscillate around
it by two or three pixels, rather than holding mgateady. This can be due to several
different faults, such as poor drive accuracy, windnditions, or bad seeing, but may
also be caused by an excessive ‘Loop gain’ in éfegaiider feedback loop. Try
increasing the ‘Pixels per second’ values in therapriate default setting box, until
stable following is achieved. Once the guider isupecorrectly, it should hold a guide
star within 1 pixel of its correct position indetely, and you can try taking test
exposures of various objects to confirm its accurac

After your first test of the self guider, thereaigiood chance that the set-up will still
need some optimising. You have the option of madnsaiting test values of
backlash and hysteresis, or using the ‘Trainingtiree in the software. Backlash is
the time delay between a reversal of a drive mamalthe start of a positional
correction of the telescope. Hysteresis is the tirtekes for a motor to stop, after the
power is removed. Many mounts have internal so#warcompensate for these
errors, but you may need to set values other teemtp get the best performance
from less sophisticated ones.

The ‘Training’ option can be used as follows:

Select a star to guide on, and then the driveitrgiperiod, using the ‘radio buttons’.
The best training time will vary with the resporspeed of the mount, but use as long
a time as possible, consistent with not losinggihiele star out of the guide window.
Start the training cycle and the software will tlseguentially drive the telescope in
all four directions, while recording the displacerhef the reference star. After the
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cycle has completed, the optimum correction spdgatsklash correction and
hysteresis values will have been calculated aretted into the default boxes. Note
that the pixels per second rate for the R.A. coiwaawill vary with the cosine of the
declination angle, so you may need to alter thigejaor re-train the system when
changing between objects at widely different dextlons.

Exposure times and image calibration

S.T.A.R. 2000 will enable you to greatly extend ¢ix@osure times of astronomical
images and so detect much fainter objects. Theitighfactor is set largely by the
increasing effect of light pollution on these exted exposures, but dark sky sites will
permit 30 minutes, or more, to be used. You wgbdbegin to see signs of amplifier
luminescence at the upper left-hand corner of ymages and this will make dark
frame subtraction more important than usual.

The software includes an option to generate prgpedtched dark frames, by
recording the number of guiding downloads execditathg the taking of the image
and using this to add the correct amount of angpldgiow to the resulting dark frame.
To use this option, you must record the dark fraimmediately after the ‘light

frame’, or the download count will be lost. Simplyver the ‘scope aperture, select
‘Take matching dark frame’ in the self guider pafrthe camera control interface and
press ‘Take Photo’. Application of the ‘Gradientdr’ (under the Filter Menu) can be
used as a final ‘tweak’, if necessary.

Flat field frames can be taken in the usual way, @e not affected by the use of
S.T.A.R. 2000.

A clip from a self-guided ‘STAR 2000’ SXV-M5C image
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Using the add-on autoguider:

An alternative to STAR2000 and a very useful acmgsis the add-on autoguider
head, which takes its power and control signaksadly from the SXV camera, via the
18 way socket on its rear panel. The autoguidenkg 1.25” in diameter and has a
video style ‘CS’ mount thread in its nose, so vitlstses may be attached. The guider
may be used with either an off-axis prism assemimynted in front of the SXV
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camera, or with a separate guide telescope, rigndlynted alongside your imaging
telescope. | personally use it with an 80mm aperk#, inexpensive refractor as a

guide ‘scope, but a shorter focal length lens mi#lke more guide stars available in
any given region of sky (See the picture below).

To use the autoguider, first orient it so that¢banector plug is roughly parallel to
the declination axis of your mount. This is nota@hbtely essential, as the training
routine will learn the angle of the head and conspémfor it, but it is easier to
understand the motion of the guide star if the gufctame is aligned with the RA and
Dec axes. Now connect the head to the SXV camenag the 18 way connector lead,
including the port divider box, if it is to be used

The recommended way of connecting the autoguidgubto the mount is to use an
RJ11 telephone lead between the socket on the @¥\é@ and the autoguider input
of your mount. This output is ‘active low’ (i.e.gftontrol relays pull the guider inputs
down to zero volts when applying a guide corregtenmd matches most of the
autoguider inputs on commercial mounts. If ‘activgh’ inputs are needed, or a very
low control voltage drop is essential, then you wéed to add a Starlight Xpress
‘relay box’ between the guider output and the injpuhe mount. Please contact your
local distributor if a relay box is required. Someunts (Vixen, for example) use a
similar guider input socket, but have re-arrangaghections. Details are given on our
web pages at the end of the ‘STAR2000’ section.
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The autoguider installed on a 80mm refractor gtsdepe in the author’s garden
To use the autoguider, please proceed as follows:

1) Having started the SXV-M5C software, open the auitbgy control panel by
clicking on the autoguider menu button.
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The autoguider control panel with a guide starcdete

Press the ‘Start’ button and a series of 1 secapdseire guider images will
begin to appear in the picture frame. If the imadgek too dim, use the
‘Stretch Image’ slider to increase its contrast Brightness until the noise
begins to be visible.

If you haven’t focused the guider lens or ‘scopeyethe mount until a bright
star is visible on the guider image and then adhesfocus until it is as sharp
as possible.

At this point, you may want to test the guiding tohby pressing the manual
‘Move Telescope’ buttons at the bottom left corakthe control panel. You
can watch the position of any stars in the guidexge and confirm that they
move in response to the buttons. The movement ghmutlow if the correct
guiding rate is selected on your mount (typicakkysidereal). Adjust this, if
necessary.

Move the mount until the required object for imagis properly framed in the
main CCD image (leave the guider menu and use #ie camera control
panel, as necessary).

Re-open the guider control panel, start imagingtantb locate a clearly
visible guide star. If necessary, make adjustmintise guide telescope or off-
axis guider until one is found.

Press ‘Stop’ and then press ‘Select Guide State. tie mouse to left click on
the selected star and a green cross will highligintd the co-ordinates will
appear in the text boxes above the image window.

The various guiding rate defaults, listed on tightdhand side of the control
panel, are unlikely to be perfect for your parteaukelescope and mount. You
have the option of manually selecting values, &masthe software to attempt
to determine what they should be. This is donerkgging the ‘Train’ button
and waiting for the software to complete a sequehe@itomatic moves and
calculations. The training will also determine #drggle at which the guide
camera is oriented with respect to the RA and Des.af you do not wish to
train the system at this time, the default values pixels per second will
serve as a starting point.

Now press ‘Go to main camera’ and the guider copi@oel will be replaced
by the camera control panel. Set the required expdsme for the image (say
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5 minutes) and press the ‘Autoguide next imagetdmutThe autoguider
window will reappear and, after a few seconds, stoould see error values
appearing in the text windows at the top. The gside will be fairly close to
the green cross, although not necessarily accyregeitred, and you should
see the power/ guide LED on the rear of the cammeghten and change
colour with each correction.

10)If the star begins to drift away from the crossspte the corrections being
made, the chances are that the N/S and/or E/Wtidinscare set wrongly.
Judge which axis is incorrectly set by observirgdirection of the drift and
then stop the exposure by pressing ‘Esc’. Opemytier control panel and
check the appropriate swap box(es). After this afp@m, you will probably
need to find the guide star again by taking a guitl@age and reselecting the
star, as before. Now return to the main camera raedtiry the ‘Autoguide
next image’ button again.

11) Once guiding is taking place without problems, tieen exposure can be
allowed to finish and, if all is well, you shouldesan image with tiny circular
stars.

If the stars are not circular, you may need tarahlie guiding parameters, or
investigate the rigidity and drive performance ofigmount. A lot of information
can be deduced by watching the behaviour of theéegsiiar in the guider frame. If
it is continually moving between two locations heit side of the green cross, then
the RA or Dec pixels per second value is set tao the higher these values are
set, the gentler the guiding becomes. Too low aevalill cause an over-
aggressive correction to be made and result illason of the star position
between two points.

Another source of guiding errors can be a too ately balanced telescope
mount! Good balance can result in the telescopentrtbouncing’ between the
gear teeth as corrections are made. A simple tia &d a weight of about 0.5kg
(2 pound) on the eastern end of the declinatios, & that there is always some
pressure acting against the gear teeth.

Getting a good result from an autoguider will ofeartail a lot of detective work
to eliminate the sources of gear error, telesctgpaife, mirror shift etc., but the
final result is well worth the effort!
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Camera maintenance:

Very little maintenance is needed to keep the SX%Mn excellent operating order,
however two problems, which are common to all C@Dipment, are likely to show
up on occasion. These are dust and condensation.

Removing Dust:

1) Dust can be deposited on either the optical awn¢hot a big problem to cure), or
on the CCD faceplate (difficult to eliminate enlyde When small particles collect on
the window they may not be noticed at all on ddgp(small F ratio) images, as they
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will be very much out of focus. However, if a poficontrast boost of the image is
carried out, they may well begin to show as thaleta’Do-nuts’ mentioned earlier.
Images taken with a large F ratio optical systeenmaore likely to be affected by such
dirt, owing to the smaller and sharper shadowsttiet cast. There is no great
difficulty in removing such particles on the outsisurface by the careful use of a lens
cleaning cloth or ‘air duster’ and so you shouldébhttle trouble with this aspect of
maintenance. Dust on the CCD faceplate is a mueltgr nuisance, as it casts very
sharply defined and dark shadows and it entailsaiitling the camera to get rid of

it! To clean the CCD you will need a good qualigns$ cloth (no silicone) or tissues
and some high-grade isopropyl alcohol. A very sié@aloth is the ‘Micro-Fibre’

type marketed by PENTAX etc., and suitable alcahalvailable from TANDY

(Radio Shack) etc. as tape head cleaning fluidrighblight and a strong
watchmakers eyeglass will also be found essential.

Procedure:

1) Disconnect the lead from the camera head andvenm from the telescope. Place
it on a table with the optical window facing dowmdia

2) Remove the two M3 screws from the camera baate@nd ease the plate out of
the camera body. You may need to press down witigar on the USB socket while
pulling up on the camera barrel to overcome thatim.

3) Withdraw the body cylinder and unscrew the tasog spacer pillars from the heat
sink plate assembly.

4) The entire camera electronic assembly can noliiteé away from the camera
front barrel and the CCD will be readily accessilNete that a layer of white heat-
sink compound is applied to the periphery of thattsenk disc and this should be left
undisturbed by subsequent operations.

5) You can now closely examine the CCD faceplatdeuthe spotlight using the
watchmaker's glass when any dust motes will shearly. If there is only an odd
particle or two and the CCD is otherwise cleaneftdly brush away the dust with a
corner of your lens cloth. A smeared or very d@38D will need a few drops of
alcohol to clean thoroughly and you may have toersdveral attempts before the
surface is free of contamination. One gentle wipenfone end to the other, with no
return stroke, will be found to be the most effeetaction. DO NOT rub vigorously
and be very careful to avoid scratching the window.

6) Before re-assembly, make certain that the insigt&ace of the front window is also
clean, and then carefully replace the camera fvantel and screw it into place. (If the
heat sink seal is disturbed, renew it with fresmpound before reassembling).

7) Replace all the camera parts in reverse ordetlanjob is done.
Dealing with condensation:

The SXV-M5C is designed to avoid condensation by mising the volume of air
trapped within the CCD cavity. This normally woudusite well, but storage of the
camera in a humid location can lead to the tragneldecoming moist by diffusion
through the optical window mounting thread etc. eggiilt in condensation on the
CCD window. If this becomes a problem, try to stibre camera in a warm, dry place,
or in a plastic lunch box containing a sachet liéaigel desiccant.
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N.B. DO NOT leave the camera switched on for longripds between uses. The
cold CCD will collect ice by slow diffusion througany small leaks and this will
become corrosive water on the cooler and CCD pirewthe power is removed. If
substantial amounts of moisture are seen on the C@dmantle the camera and
dry it thoroughly.
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Alternative Software

Although we hope that you will be satisfied withix® _M5C’, other companies are
offering alternative software. The most active andcessful of these is ‘AstroArt’ by
MSB software. You can purchase AstroArt from maegldrs Worldwide and more
information may be obtained from their web sit@idp://www.msb-astroart.com

Maxim DL is also a very popular option and may becpased from many
astronomical equipment dealers. Their web sité gtp://www.cyanogen.com
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Some details of the camera and CCD characteristics

CCD type: Sony ICX405AK ‘SuperHAD’ interline CCD imager wittMYG
filters.

CCD size: Active area 4.9 x 3.65mm
Pixel size: 9.8 X 6.3uM
QE peak: approx. 60% at 540nM

Spectral response:

Power consumption: 220v/ 110v AC @ 12 watts max., 12v DC @ 750mA
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Dear User,

Thank you for purchasing a Starlight Xpress CCDdimg System. We are confident that you will gain
much satisfaction from this equipment, but pleaselrcarefully the accompanying instruction manual
to ensure that you achieve the best performancésticapable of providing.

As with most sophisticated equipment a certain arhofiroutine maintenance is necessary to keep the
equipment operating at its optimum performance. Maemtenance has been kept to a minimum, and is
fully described in the manual.

In the unfortunate instance when the equipment doeperform as expected, may we recommend that
you first study the fault finding information supgal. If this does not remedy the problem, then acint
Starlight Xpress for further advice. Our messagarthservice on the Starlight Xpress web site will
often provide solutions to any problems.

The equipment is covered by a 12-month guaranteerice faulty design, material or workmanship in
addition to any statutory Consumer Rights of Pusehs

CONDITIONS OF GUARANTEE

1) The equipment shall only be used for normal pses described in the standard operating
instructions, and within the relevant safety staddaf the country where the equipment is used.

2) Repairs under guarantee will be free of chargeiging proof of purchase is produced, and that th
equipment is returned to the Service Agent at trelRser’s expense and risk, and that the equipment
proves to be defective.

3) The guarantee shall not apply to equipment dachdy fire, accident, wear an tear, misuse,
unauthorised repairs, or modified in any way whewgo, or damage suffered in transit to or from the
Purchaser.

4) The Purchaser’s sole and exclusive rights utiderguarantee is for repair, or at our discrettom
replacement of the equipment or any part therewf,r remedy to consequential loss or damage
whatsoever.

5) This guarantee shall not apply to componentstthge a naturally limited life.

6) Starlight Xpress's decision in all matters igafi and any faulty component which has been replac
will become the property of Starlight Xpress Ltd.

For further info. or advice, please call:

Mr Michael Hattey,

Starlight Xpress Ltd.,

The Office, Foxley Green Farm,

Ascot Road, Holyport,

Berkshire,

England. SL6 3LA

Tel: 01628 777126

Fax: 01628 580411

e-mail: Michael.hattey@starlight-xpress.co.uk

Web site: http://www.starlight-xpress.co.uk
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